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1. Introduction 
 
For polycrystalline or powder TEM specimens, electron diffraction ring patterns are extensively 
used for phase identification, in which the diffraction pattern of a known phase acts as a 
fingerprint.  
 
Computer programs of powder X-ray diffraction may be used for phase identification in the 
analysis of polycrystalline electron diffraction patterns. Electron diffraction ring pattern needs to 
be transformed into the form of integral intensity as a function of scattering angle for comparison 
with a powder X-ray diffractogram. The other approach is to use computer programs that 
implement the formula for electron diffraction intensity to analyze raw or processed 
polycrystalline electron diffraction patterns. Integrated electron diffraction software packages 
often provide a module for simulating polycrystalline electron diffraction patterns, and they 
rarely include features for direct comparison with experimental data for phase identification. A 
specially designed computer program is needed to provide a fast and accurate method for 
accomplishing this task. We developed the first version of PolyCrystalline Electron Diffraction 
(JECP/PCED, Li 2004). 
 
The next version is ProJECT/PCED2 (Li, 2010), which includes the following new features (i) 
Blackman’s theory, an integral two-beam dynamical theory, for intensity calculation, (ii) Match 
model for out-of-plane and in-plane texture, (iii) pseudo-Voigt function for peak profile of 
diffraction ring and (iv) improvement on diffraction pattern indexing and matching to an 
experimental pattern. PCED includes a Miller-Bravais index dialog for a hexagonal system, a 
space group, a better GUI, and I/O compared to PCED2. PCED2 also incorporates with Landyne 
launcher, a desktop dock for JECP, and ProJECT package.  
 
A drag and drop function was implemented, and the image operations, invert, alignment, resize, 
and rotation, were added in PCED3. The simulation of two crystalline phases was included, and 
an index system was applied in PCED4.  
 
The current version is PCED5, which upgrades the manipulation of the experimental electron 
diffraction pattern and better index labels on the simulated pattern. The label tools were added to 
prepare figures for publication. The improvement provides a much easy way for operation, 
especially phase identification.  
 
PCED was written and complied with in JDK8. Further code optimization (including obfuscation) 
was carried out on the compiled class files. A license file is needed to unlock the program 
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(PCED.jar) for loading new input data files. Without the license file, the program works in demo 
mode using default input files (Al and Mg). License is available from LANDYNE computer 
software (jlandyne@gmail.com). 
 
2. Theory background 
 
The kinematic theory of electron diffraction is described in detail in any texture book on this 
topic (e.g., Peng et al. 2004). The electron atom scatting factor can be derived from the X-ray 
atom scatter factor using the Mott-Bethe relationship or directly obtained from a parameterized 
table of electron atom scatter factors (Peng et al. 1996). Here we use the second method. 
 
Following the electron diffraction geometry, the radius of the diffraction ring, R, can be related 
to the length of the reciprocal vector g(hkl) as 
 
 

𝑅𝑅 =
𝐿𝐿𝜆𝜆
𝑑𝑑

�1 − � 𝜆𝜆2𝑑𝑑�
2

1 − 2 � 𝜆𝜆2𝑑𝑑�
2 

 
(1) 

 
Where L is the camera length, d=1/|g(hkl)| and 𝜆𝜆 is the wavelength of the incident electron beam. 
 
The integrated intensity of reflections in the electron diffraction from the polycrystalline sample 
was derived in the book by Vainshtein (1964). 
 
 

𝐼𝐼 = 𝐼𝐼0𝑉𝑉𝑉𝑉2𝑝𝑝
𝐹𝐹ℎ𝑘𝑘𝑘𝑘2

𝑣𝑣𝑎𝑎2
𝑑𝑑ℎ𝑘𝑘𝑘𝑘

2
 

 (2) 

 
Here V is sample volume, λ is the wavelength, p is a multi-factor, Fhkl is diffraction amplitude, 
the va is the volume of unit-cell, dhkl is the (hkl) spacing. 
 
2.1 Blackman’s theory on the intensity of polycrystalline electron diffraction 
 
Blackman’s theory (Blackman 1939) for polycrystalline electron diffraction intensity is based on 
Bloch wave dynamic theory initially formulated by Bethe. The formulas are given as integral 
intensity of two-beam dynamic diffraction. According to Peng et al. (2004), Blackman’s theory 
for polycrystalline electron diffraction intensity is an advanced theory on this topic, although the 
theory was published decades ago. Readers should refer to the original paper for details 
derivation of the formulas. Some essential formulas are listed here. 
 
The dynamical structure factor is given, 
 

𝑈𝑈𝑔𝑔 =
2𝑚𝑚𝑚𝑚𝑉𝑉𝑔𝑔
ℎ2

 
 

 
(3) 

 Where m is electron mass, e is the electron charge, h is Planck constant, Vg is Fourier coefficient 
of crystal potential. 
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The wave vector in a vacuum is given, 
 𝐾𝐾02 =

2𝑚𝑚𝑚𝑚𝑚𝑚
ℎ2

 
 

 
(4) 

Here E is the accelerated voltage of the electron microscope. 
 
The wave vector inside the crystal is corrected with the mean inner potential, 
 
 𝐾𝐾2 = 𝐾𝐾02 + 𝑈𝑈0 

 
(5) 

 
The diffraction intensity formulas can be given below in an integrated form considering there are 
angle distribution between the incident beam and the zone axis of the polycrystalline grains, 
  
 

𝐼𝐼𝑔𝑔
𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 = 𝐼𝐼𝑜𝑜

𝑈𝑈𝑔𝑔
𝑔𝑔𝐾𝐾2 � 𝐽𝐽0(2𝑥𝑥)𝑑𝑑𝑑𝑑

𝐴𝐴

0
  

 

  
(6) 

Where 𝐼𝐼0  is the intensity of the incident beam, 𝑈𝑈𝑔𝑔  is dynamical structure factor, 𝐾𝐾 is a wave 
vector and 𝐽𝐽0(𝑥𝑥) the zero-order Bessel function and, 
 
 

𝐴𝐴 =
𝜋𝜋𝜋𝜋𝑔𝑔𝑡𝑡
𝐾𝐾𝑛𝑛 

 

 

 
(7) 

Here  𝐾𝐾𝑛𝑛 is K normal component and 𝐾𝐾2 = 𝐾𝐾𝑛𝑛2 + 𝐾𝐾𝑡𝑡2 (𝐾𝐾𝑡𝑡 is K component in the zero-order Laue 
zone). 
The final intensity is an averaged integral intensity over 𝐾𝐾𝑛𝑛, considering the angle between the 
incident beam and the surface normal in a range from  −𝜋𝜋

4
  to  𝜋𝜋

4
 . 

 
2.2 Pseudo-Voigt function for peak profile  
 
Although Voigt (V) function, as the convolution of a Gaussian (G) and a Lorentzian (L) 
functions, is regarded as the most suitable function to describe the profile of the cross-section of 
the diffraction rings, it is rather complicated. Pseudo-Voigt (pV) function is usually a good 
enough substation for the job. the pseudo-Voigt function is a linear combination of Gaussian and 
Lorentzian function, as following (Li, 2007), 
 
 𝐺𝐺(𝑥𝑥) = ℎ𝑒𝑒𝑒𝑒𝑒𝑒(−4𝑙𝑙𝑙𝑙2(

𝑥𝑥 − 𝑥𝑥0
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹

)2) 
 

(8) 

 
𝐿𝐿(𝑥𝑥) =

ℎ

1 + 4( 𝑥𝑥 − 𝑥𝑥0
𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹)2

 
 
(9) 
 
 

 𝑝𝑝𝑝𝑝(𝑥𝑥) = 𝜂𝜂𝜂𝜂(𝑥𝑥) + (1 − 𝜂𝜂)𝐿𝐿(𝑥𝑥) (10) 
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Here h is peak height, x0 is peak position, FWHM is full width at half maximum. Figure 1 shows 
the comparison of profiles of Gaussian and Lorentzian functions. 
 
2.3 March Model for polycrystalline texture  
 
For powder samples, axially symmetric platy or capillary specimens, composed of effective disk- 
or rod-shaped crystallites, can form textures due to the shape of crystallites. For thin film 
samples, polycrystalline microstructures with out-of-plane or in-plane preferred orientations 
often occur during the film growth. The diffracted intensities from preferred orientation can be 
corrected or measured with a single pole-density profile. The March model is used for correcting 
the powder X-ray diffraction with texture, which is a simple but effective method for both out-
of-plane (platy) and in-plate (rode) textures. 
 

 
Figure 1. Comparison of profiles of Gaussian and Lorentzian functions. 

 
The formals were firstly given for X-ray powder diffraction, which is reformulated for the 
diffraction geometry in polycrystalline electron diffraction considering the diffraction geometry 
of polycrystalline electron diffraction. Figure 2 shows the example curves of the March functions 
used in X-ray powder diffraction (Bragg-Brentano geometry) and in polycrystalline electron 
diffraction for platy (out-of-plane) texture. Referring to Figure 1 in the paper by Dollase (1986), 
the preferred zone axis density for polycrystalline electron diffraction can be formulated as 
follows. 
 
For out-of-plane texture,  
 𝑃𝑃𝑔𝑔(𝑂𝑂) = 𝑃𝑃𝐺𝐺(𝛼𝛼) = (𝑟𝑟2𝑠𝑠𝑠𝑠𝑠𝑠2𝛼𝛼 + 𝑟𝑟−1𝑐𝑐𝑐𝑐𝑐𝑐2𝛼𝛼)−

3
2 

 

 
(11) 

 
For in-plane texture, 
 

𝑃𝑃𝑔𝑔(𝑂𝑂) = 𝑃𝑃�𝐺𝐺(𝛼𝛼) = 2
𝜋𝜋� 𝑃𝑃𝐺𝐺(𝛼𝛼,𝛽𝛽)𝑑𝑑𝑑𝑑

𝜋𝜋
2

0
 

 
(12) 
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If the axial pole-density profile, 𝑃𝑃(𝜑𝜑) is known, 𝑃𝑃�𝐺𝐺(𝛼𝛼) maybe obtained by numerical integration 
making use of the relation among coordinates: 𝜑𝜑 = cos−1(sin𝛼𝛼 cos𝛽𝛽). 
The intensity of polycrystalline electron diffraction including texture can be expressed as,  
 
 

𝐼𝐼𝑔𝑔
𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 = 𝑠𝑠�𝑃𝑃𝐺𝐺(𝛼𝛼𝑖𝑖)

𝑚𝑚

𝑖𝑖=1

𝐼𝐼𝑔𝑔
𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖𝑖 

 
(13) 

 

 
Figure 2. Example curves of the March functions used in X-ray powder diffraction (Bragg-
Brentano geometry) and polycrystalline electron diffraction for platy (out-of-plane) texture. 
Angle away from the preferred orientation is in abscissa and the density (or weight) inordinate.   
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Figure 3. Snap-shot of the primary interfaces of   PCED, a simulation of polycrystalline electron 

diffraction in a two-phase system, Al and Mg.  
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Figure 4. Snap-shot of the primary interfaces of   PCED, a phase identification using calculated 

polycrystalline electron diffraction pattern. The experimental PCED pattern is Al.  
 
Where s is the scale factor, Pg(αi) is the density of g(hkl) poles at the scattering vectors, and αi 
refers to the angle between G(HKL) and the ith member of the symmetry-equivalent set of m 
diffraction planes. The preferred orientation plane itself is a member of some set of symmetry-
equivalent planes. Suppose the dominant morphological feature of the crystallites is re-indexed 
as some other member of this set. In that case, the individual values of αi in the above will be 
permuted, but the sum of terms remains the same. The sum can be considered as a generalized 
multiplicity term. 
 
3.  The graphic user interface of PCED 
 
3.1 Main interface 
 
The main interface of PCED is shown in Figures 3 and 4, which includes a menu and a toolbar to 
take input parameters and a frame to show the output of the simulation. The usage of PCED for 
simulation needs to load structure data and to set up input parameters, then simply click the 
Run button in the Calculation dialog (shown later). The usage of PCED for phase identification 
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needs to load the experimental diffraction patterns first and then to match the calculated patterns. 
Two structure data can load at the same time for comparison or simulation of a two-phase system. 
 
3.2 Menu and toolbar 
 
Menu and toolbar can be used to pop up dialogs for data and parameters. The toolbar can also be 
hidden. Most functions of the menu and toolbar are the same; some functions are only provided 
either in the menu or in the toolbar, e.g., the drag-and-drop box for loading EDP in formats of 
JPEG and TIFF. 
 
Crystal menu provides an interface for preparing the new crystal data for loading the crystal 
data for phase 1 and phase 2. The file name can be viewed on the Parameter table in a dialog.  
 
Experiment menu provides an interface to load experimental polycrystalline electron diffraction 
(PCED) pattern in JPEG and TIFF format. The loaded PCED pattern can be inverted the grey 
color and can also be erased. The pattern can be resized and rotated for the best display. The 
pattern can be shifted to view the scale bar and make the calibration of the simulation using a G-
spacing marker. The pattern can be shown in full or half mode. The file name can be displayed or 
hidden.  
 
Simulation menu provides a submenu for the choice of electron diffraction theories and several 
dialogs (e.g., average grain size, peak profile, texture model) for input parameters in the 
simulation. Two theories are used for the calculation of electron diffraction intensity. The 
kinematical theory is selected by default, and the second choice is Blackman’s theory, which is 
an integral two-beam dynamic theory. Intensities calculated by Blackman’s theory are more 
accurate than those calculated by kinematical theory, but the calculation of dynamic theory will 
take a longer time. A dialog of an index label is used to adjust the position and font size of the 
index. A conversion tool is for Miller and Miller-Bravais index for a hexagonal system. A dialog 
of parameter-table is used for monitoring the parameters in the calculation.    
 
Pattern menu provided the output of the simulated patterns, the hkl intensity list, the preference 
of the hkl-inten list file, and print to a printer or a PDF file when a PDF print driver was installed. 
 
Options menu provides the look-and-feel provided by Java; an option to hide or show toolbar; 
freedom of customizing the appearance of simulated pattern; for example, the diffraction peak 
and ring color, the curve or solid profile; set the reciprocal spacing for a marker. 
 
Help menu provides a tool to find the current driver and its serial number (S.N.), a table of space 
group numbers and symbols, version information.  
 
4. Usage of PCED 
 
The recommended way is to use Landyne launcher. The other ways are either double click 
PCED.jar. In the following, we show step by step from preparing structure data file, common 
routine usage for simulation, and to the last steps of saving and printing the results. More details 
on specific topics are left to the next section.  
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4. 1 Prepare new crystal structure file 
 
A structure data file can be prepared using the New Crystal Structure File dialogue window in 
Figure 5. The dialogue window provides an automatic assistant for the user and makes sure to 
meet the requirement of the file format. The template is embedded with the 230 space groups in 
the Hermann-Mauguin notation, which list in the international table for crystallography. 
However, only b unique axis will be used in a monoclinic system. Two origin choices can be 
accepted as input parameters, but choice-2 will be converted to choice-1. To save the data 
structure, click the Save button; or make a new one click the New button.  
 
 

 
Figure 5. Snap-shot of the preparation of the new crystal structure file.  

 
The crystal file can be also converted from a previous data for modification or from a 
crystallographic information file (CIF). If a data file in an alternative setting of space group for 
triclinic, monoclinic and orthorhombic systems is used, please click on the alternative settings 
(1~74). A tool for the transformation of files in the nonconventional notations to the standard 
notations is provided.  
 
4.2 Simulation 
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The kinematical theory is used as a default selection in the simulation since it is fast and fewer 
input parameters are required. Integral dynamical two-beam theory (Blackman’s theory) can be 
turned on using the Theory submenu in the Simulation menu.  
 
Basic parameters for calculation and adjustment of the diffraction pattern can be filled in or 
changed in the Calculation dialog in Figure 6. To generate new 
diffraction pattern needs, click the Run button. The pattern is 
automatically updated, corresponding to the change of other 
parameters.  
 
Mass ratio defines relative masses of the two phases when the fields 
of phase1 and phase2 are checked.  
 
Volume ratio defines relative volumes of the two phases when the 
fields of phase1 and phase2 are checked.  
 
g-spacing zoom and Intensity scale simulated the camera length and 
the exposure time in the experiment, which is used to make a better 
appearance of the calculated pattern.  
 
Peak type can be chosen from the integral intensity on a ring or 
intensity on unit-arc-length. 
 
The diffraction diagram can be viewed as peak and profile  
separately or together. 
  
Diffraction ring can be viewed as either a ring to match the 
experiment pattern or only the top half in order to clearly show the 
index without intervening or without a ring at all. 
 
The diffraction ring's appearance is also controlled by the profile 
intensity (intensity threshold).   
 

Figure 6. Snap-shot of the calculation dialog.  
 
4.3 Index and intensity label 
 
There are cases that diffraction peaks are quite dense; the index labels may be overlapped when 
they are shown by the side of the diffraction diagram, especially for the diffraction diagram of 
the two-phase system. It is essential to allow users to adjust the positions of the index (and 
intensity) labels. 
 
In order to avoid the situation, PCED is allowed to select the location of an index label and to 
spread it when necessary. In the Index Label dialog, a top point can be viewed when the 
checkbox of the Top point is selected and moved around with mouse drag-and-drop. Dash 
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line can be viewed when the Baseline’s checkbox is selected and moved up/down by the mouse 
wheel or the arrow keys (after clicking  the panel). 
 
Figure 7 shows the example for adjusting the positions of index labels. The Label dialog 
provides i) remove indexes of the weak diffraction peaks; ii) position adjustment; iii) the font 
size for phase 1 and phase 2.  To use the position adjustments of the index labels, i) select phase 
1 or phase 2; ii) tick the checkbox for index; tick the checkbox for the guidelines; iii) select Top 
point or Baseline; iv) move the mouse pointer to adjust the positions of index labels by a drag-
and-drop operation; v) remove the indexes of weak diffraction peaks by increasing the intensity 
level (arbitrary unit); vi) select the link lines on or off; vii) choose the proper font size.   
 
4.4 Phase Identification 
 
It is fairly easy to make a phase identification using PCED. An experimental PCED pattern and 
the crystal data of the possible phases are needed. The PCED pattern is in JPEG (.jpg) or TIFF 
(.tif) formats, which can be quickly loaded using the window file system in a menu or the drag-
and-drop box in the graphic menu bar. The PCED pattern can be processed, such as resize, rotate, 
and center, as shown in Figure 8. The scale-bar on the PCED pattern can be used for calibration 
of the G-spacing zoom in Figure 9. The PCED pattern can be displayed in full or half size. The 
simulation of the possible phases is then calculated on the right side of the pattern panel if the 
positions and intensities of the diffraction rings are matched in agreement with the experimental 
PCED pattern.  

 

 
Figure 7. Example for the Label adjustment. Snapshot of the Label adjustment dialog.  
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Figure 8. Snap-shot of the image operation, such as alignment, resize, and rotation.  

 

 
Figure 9. Snap-shot of the G-spacing marker. 

 
The phase identification is made; otherwise, the next possible 
phase is loaded for a check until all possible phases are run 
out.  
 
For the hexagonal system, the index can be the three-index 
Miller notation or the four-index Miller-Bravais notation. 
Three-index Miller notation is used in the PCED. A tool for 
converting the Miller notation and Miller-Bravais notion is 
also provided, as shown in Figure 10. 

 
Figure 10. Snap-shot of the Hexagonal system index.  

 
4.5 Output for publication 
 
Calculated diffraction data can be saved into a file using Save in File menu, in which it includes 
hkl and intensity (per unit-length) together with the parameters used in the simulation as a 
default option. More info, such as length of a reciprocal vector (g), crystalline plane spacing (d), 
intensity (per unit angle), can be chosen to be saved by using selection in hkl-inten dialog in the 
options menu.   
 
Simulated diffraction patterns and preloaded experimental patterns can be saved as output files in 
TIFF and JPEG format. The output size can be selected through the region of interest (ROI) and 
the point per inch (PPI). A tool for figure label is available, so the figure in one-step to be used 
for publication. An example figure and the tool for the figure label are shown in Figure 11. 
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Figure 11. Snap-shot of output and a tool for figure label. 

 

 

Figure 12. Snap-shot of experimental pattern processing, resize, rotation, and center.  
(Snapshot of PCED) 
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5. Special topics on PCED 
 
5.1 Partial occupancy factor and isotropic temperature factor 
 
Some atom coordinates maybe not in full occupancy in a crystalline structure. In this case, the 
occupancy factor (default value 1.0) should be changed to the values according to the crystalline 
structure in preparation for the structure data file for polycrystalline electron diffraction 
simulation.  
 
The partial occupancy factor can also be used to simulate a certain level of chemical order in 
structure. For example, the chemical ordered FePt L10 phase, see section 6. In this case, a 
different type of atoms may be assigned to the same atomic coordinates with different occupancy 
according to the chemical ratio. However, the sum of the two atoms' occupancy factors is 1.0. 
 
Isotropic temperature factor is used here to simulate the effect of lattice vibration (Debye model). 
Although the isotropic temperature factor is a rough model, it can be used to simulate the 
decrease of the diffraction intensity with the variation of the |g| value. The higher the value of |g|, 
the more decrease of the diffraction intensity. 
 
5.2 Load and center EDP  
 
For phase identification, the experimental polycrystalline electron diffraction pattern is needed to 
load up and compare with simulated patterns, which were calculated from the related phase files. 
The experimental pattern should be in JPEG and TIFF formats. The experimental pattern can be 
loaded using the Load in the Experiment menu or drag-and-drop box and then resized / rotated / 
centered. Once Shift & Center is clicked, concentric circles will appear in the main panel. Select 
the center of the pattern using a mouse and hold on the left button of the mouse; the pattern can 
be dragged and drop into the center of the panel, see Figure 12. Click the Shift & Center again; 
the PCED pattern is locked up in the position, and concentric circles disappear. More 
adjustments in small steps may be needed to find the accurate position. The number of concentric 
circles can be changed using the Number of Reference Circle. 
 
5.3 Peak profile, incident beam, and texture 
 
Profile of the cross-section of diffraction ring is referred to as peak profile, which can be 
simulated using a pseudo-Voigt function, together with grain size (diameter) and constant K. The 
ratio of Gaussian and Lorentzian functions in pseudo-Voigt function can be adjusted using Peak 
Profile in the Simulation menu (default value is 0.5). The grain size (diameter) and constant K 
can be adjusted using the Average Grain Size dialog in the Simulation menu. 
 
The Incident beam in polycrystalline electron crystalline is very strong comparing to the 
diffraction ring; it may submerge the relative week rings near the incident beam. The incident 
beam can be included in the simulated pattern by check on the Included box in the Peak 
Profile dialog and adjust the shape by changing the corresponding values of height and fwhm. 
Peak and profile can be selected individually, and the style of profile can be chosen between a 
solid shadow or curve.  
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5.4 Parameter table 
 
In texture dialog, the axis of texture and March parameter (default value 1.0 for full random 
case) can be input for simulation. These values can be set up separately for phase1 and phase2.  
March parameter (r) is suitable for describing the slight deviation of the randomness of 
polycrystalline/or powder sample. Thus the higher the value, the better approaching the 
randomness.   
 
To describe the status of preferred orientation, we suggest using the reversed March parameter r’ 
= 1.0 - r. Thus, full randomness r’ = 0, the higher the preferred orientation, the higher the value 
of r’ and for the perfect prefer orientation r’ = 1.0.  
 
For convenience to track down the simulation parameters, a Parameter Table can be pop up 
using Parameter Table in the Simulation menu, which lists the essential parameters of phase1 
and phase 2.  
 
5.5 Determine the weight ratio of a two-phase system 
 
PCED provides a way to simulate the composite diagram of the two-phase system with a given 
weight ratio. The formula used in the program is to convert the weight ratio into the numbers of 
unit-cell in diffraction using atomic weight per unit-cell for each phase for simplicity. 
Experimentally determining the two-phase system’s weight ratio should be calibrated by using a 
standard sample with a known weight ratio.  
 
5.6 Grain size and the FWHM of diffraction ring 
 
PCED provides a way to simulate the FWHM of diffraction rings for a given average grain 
diameter and K factor. The values of FWHM for each ring in the calculated diagram are 
consistent with the same pseudo-Voigt function used in the simulation. The diffraction rings in 
the experimental pattern are often composed of separately individual spots from grains with 
different grain size; the peak profiles are obtained by using data sum up to around each ring. In 
such a case, the peaks may need to fit different pseudo-Voigt functions for each ring. The grain 
size is not related to the peak profiles of polycrystalline electron diffraction ring pattern in a 
simple way. The grain size should be measured by using a bright field or dark field imaging 
method. 
 
6. Examples 
 

6.1 Phase identification of the Cr-N thin films  
 
According to the phase diagram of the Cr–N system (Venkatraman & Neumann, 1990), the Cr2N 
phase is stable with a nitrogen composition range of about 27.5–33 at.%, and the CrN phase has 
a very narrow equilibrium range (47.5–50 at.% N). CrN has a face-centered cubic (f.c.c.) 
structure (a = 0.414 nm) while Cr2N has a hexagonal structure (a = 0.4752 nm and c = 0.4429 nm) 
(Villars & Calvert, 1985).  
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It is well known that Cr–N thin films have been studied continuously as important coating 
materials. On the other hand, our research on Cr–N films originated from studying Cr-doped AlN 
(AlCrN), a ferromagnetic semiconductor system. To clarify the origin of the ferromagnetism, we 
must exclude the contributions from any possible second phases in AlCrN, including CrN and 
Cr2N. Therefore, the structure and properties of Cr–N films were studied (Li, et al. 2004).  
 

 
Figure 13. Comparison of calculated polycrystalline electron diffraction patterns of  

(a) f.c.c. CrN, (b) hexagonal Cr2N and (c) b.c.c. Cr, with intensities  
(b) on top and indices at the bottom of each peak.  

 
Cr–N films were grown on Si (001) substrates by reactive magnetron sputtering under an N2/Ar 
atmosphere at room temperature. The composition of the films, expressed as Cr1-xNx, can be 
varied by changing the N2/Ar pressure ratio during the synthesis process. Two batches of thin 
films were prepared with different N2 partial pressures, sample 1, P(N2) = 5 x 10-1 Pa and sample 
2, P(N2) = 5 x 10-3 Pa. 
 
Simulation of the polycrystalline electron diffraction patterns from CrN and Cr2N and Cr 
 
Fig. 13 shows the calculated polycrystalline electron diffraction patterns of the structures of (a) 
the f.c.c. CrN phase (Villars & Calvert, 1985), (b) the hexagonal Cr2N phase (Kim et al., 1990) 
and (c) b.c.c. Cr. The calculated patterns show that it should be possible to distinguish the CrN, 
Cr2N and Cr phases by their polycrystalline electron diffraction patterns. 
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Figure 14. Experimental polycrystalline electron diffraction patterns of thin films produced (a) 
with N2 partial pressure P(N2) = 5 x 10-1 Pa and (c) with N2 partial pressure P(N2) = 3 x10-3 Pa. 

Simulated patterns (b) based on the cubic CrN structure and (d) based on the cubic CrN structure 
with half occupancy of N sites. 

 
Thin films produced with different N2 partial pressure 
 
Fig. 14 shows (a) a polycrystalline electron diffraction pattern taken from sample 1 and (b) a 
simulated pattern calculated on the basis of the structure of the f.c.c. CrN phase. Both the radii of 
the rings and their relative intensities are in good agreement, confirming that the microcrystalline 
phase in sample 1 is the f.c.c. CrN phase. Fig. 14(c) shows a polycrystalline electron diffraction 
pattern taken from sample 2. The simulated patterns (see Figs. 13b and 13c) of the hexagonal 
Cr2N phase and Cr do not fit the experimental pattern. The radii of the rings in the experimental 
pattern are the same as those in Fig. 14(a), although the relative intensities of corresponding 
rings are different. Therefore, the microcrystalline phase in sample 2 should have the same or a 
very similar type of unit-cell and lattice parameters. Considering the fact that sample 2 was 
synthesized under a low N2 partial pressure compared with that used for sample 1, we tried to use 
the structure of the cubic CrN phase with vacancies to interpret Fig. 14(c). A simulated pattern is 
shown in Fig. 14(d), which is calculated using the structure of the cubic CrN phase with half 
occupancy at N sites. This figure shows that the intensity of the inner most ring dramatically 
increased while the intensities of other rings do not change very much. The simulated pattern in 
Fig. 14(d) can be used to match the experimental one in Fig. 14(c); thus, the microcrystalline 
phase in sample 2 can be interpreted as the cubic CrN phase with vacancies at the N sites. 
 
6.2 Analysis of thin films with FePt L10 phase   
 
In order to increase the areal density of magnetic recording media, the grain sizes of the 
magnetic films must be reduced. A high-anisotropy material is thus essential for the new media 
to retain thermal stability. The high anisotropy energy of the FePt L10 phase makes the FePt 
alloy system one of the most promising materials candidates. As-deposited FePt films typically 
consist of the disordered fcc phase, which is a magnetically soft phase and can be transformed 
into the L10 phase upon annealing treatment. The chemical order of the L10 phase depends on the 
composition and the heat treatment condition of the film. 
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For data-storage applications, the [001] axis of the L10 phase should be perpendicular to the film 
plane since the [001] axis of the L10 phase is an easy magnetic axis. Hence, the films in a (001) 
texture have an advantage over randomly or other (e.g. (111)) oriented films. One way to achieve 
the (001) texture has been developed by depositing a multilayer of Fe and Pt film and annealing 
at elevated temperature. The formation of the (001) texture for various ranges of film thicknesses 
was a focus point in the research work.  
 

 
Figure 15. SAED pattern of the FePt L10 phase in a film with a thickness of 20 nm annealed at 

600 °C for 30 seconds and calculated pattern for phase identification. 
 

  
Figure 16. SAED pattern of the FePt L10 phase in a film with a thickness of 4 nm annealed at 

600 °C for 30 seconds and calculated pattern with (001) texture. 
 
FePt film with a thickness of 20 nm  
 
Figure 15 shows the SAED pattern of FePt film with a thickness of 20 nm annealed at 600 °C for 
30 seconds and the calculated pattern of the FePt L10 phase-in for phase identification. The ring 
radiuses and corresponding intensities in the calculated pattern are considered to match well with 
the experimental pattern. On the other hand, the ring radiuses and corresponding intensities in the 
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calculated pattern with FePt fcc polycrystals (not shown here) do not match the experimental 
pattern. Thus the phase is confirmed to be the chemical ordered FePt L10 phase.  
 
FePt film with thickness 4 nm 
 
It is clear that the radius step of the diffraction patterns in Figure 15 is the same as those in 
Figure 16; however, the intensity distributions of the diffraction patterns are dramatically 
different. Now we estimate the (001) texture of the film with a thickness of 4 nm semi-
quantitatively.   
 
Fig.17 is a processed digital diagram of Fig.16 using a program QPCED (Li, 2007). Using March 
parameters of 0.45 and a given chemical order (Pt sites with 80%Pt+20%Fe; Fe sites with 
80%Fe+20%Pt), a calculated diagram in Fig.18 is best matching with Figure 17 is obtained. As 
discussed in section 5.3, if we use revised March (0.0 for full random and 1.0 for perfect texture), 
the texture can be described as 55% of the (001) texture.  
 

 
Figure 17. Digital processed diagram of the experimental electron diffraction pattern in Figure 17. 

 
Figure 18. A simulated diffraction diagram fitting to Figure 18 reveals the degrees of chemical 

order and (001) texture of film with a thickness of 4nm. 
 

7. Installation of PCED 
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7.1 Installation 
  
Download and install the most recent JRE from the Java official site. Download and install the 
JAI, which is also available at https://www.unl.edu/ncmn-enif/xzli/download.  
 
Download (https://landyne.com) and decompress the Landyne5 package. Copy the license to the 
programs\ subfolder.   
 

7.2 PCED in Landyne suite  
Click the PCED in Landyne launcher to start the software. 
 

7.3 License   
A license file is needed to unlock the program (PCED.jar) for simulating PCED patterns. The 
program may run in demo mode, which works in full functions but limits to the given crystal 
files. A license is available from LANDYNE (computer software and graphic design).  
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